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3.1 Ofiso programos – Word redaktorius 

3.1.1 Susipažinimas su Microsoft Office Word 

3.1.1.1 Microsoft Office mygtukas 
"Microsoft Office" mygtukas yra viršutiniame kairiajame kampe iš šių Microsoft Office sistema 

programose: Word, Excel, PowerPoint, Access ir Outlook (kaip parodyta 1 pav.) Kai paspausite 

"Office" mygtuką pamatysite tas pačias pagrindines komandas galima rasti failo meniu ankstesnes 

versijas "Microsoft Office" atidaryti, išsaugoti ir atspausdinti failą..  

 

Iliustracija 1: Microsoft Word Basic Buttons  

3.1.1.2 Greitosios prieigos įrankių juosta  
Sparčiosios prieigos įrankių juosta (parodytas 2 paveiksle) pasirodo Access lango viršuje ir suteikia 

jums vienu paspaudimu nuorodas į dažniausiai naudojamas funkcijas. Galite tinkinti įrankių juostoje 

turinį paspaude "žemyn" rodyklės piktogramą iš karto į įrankių juostos dešinėje..  

 

Iliustracija 2: The Quick Access Toolbar 

Pagal nutylėjimą, sparčiosios prieigos įrankių juosta yra mygtukai Išsaugoti, Undo ir Redo. Galite 

tinkinti įrankių juostą pridedant piktogramas Naujas, Atidaryti, E-mail, Spausdinti, Spausdinimo 

peržiūra, Rašyba, režimas, atnaujinti visus ir kitas funkcijas. 

3.1.1.3 Antraštės juosta  
Pavadinimo juosta yra horizontali juosta aktyvaus dokumento viršuje. Ši juosta rodo dokumento ir 

programos pavadinimą. Tuo dešiniajame gale pavadinimo juostoje yra Sumažinti, atkūrimo ir 

uždarosios mygtukai. 

3.1.1.4 Įrankių kaspinas 
Kaspinas yra visame ekrano, kuri leidžia prieigą prie beveik visų "Word" funkcijų iš vienos srities 

viršuje plotas.Juostelės pakeičia meniu ir įrankių juostas į ankstesnes versijas.Juostelės atskleidžia 
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dauguma funkcijų, kurios naudojamos paslėpti File meniu. Ji tampa lengviau pamatyti ir sužinoti 

komandas formatuoti ir redaguoti savo dokumentą.Juostelės gali būti sumažintas iki vienos eilutės 

skirtukų paspausdami CTRL + F1 arba dukart paspaudę ant aktyvaus skirtuko. 

3.1.1.5 Liniuotė 
Liniuotė funkcija Microsoft Word yra naudinga pozicionavimo atrankas tekstą dokumente. Galite 
naudoti liniuotę siekiant reguliuoti paraštes įtraukos ir tabuliacijos žingsniai vieta, aplink kurią jums 
vieta jūsų tekstą. "Word 2007", valdovas yra paslėpta pagal nutylėjimą, todėl jūs turite parodyti jį 
esant spausdinimo maketo rodinyje (žr. 3 pav.) Su Klasikiniai Meniu "Word 2007 arba 2010 įdiegta, 
jūs galite spustelėti meniu skirtuką. Tada jūs turite  
1. Spustelėkite meniu Rodymas  
2. Pasirinkite valdovas išskleidžiamajame meniu  
3. Tada pamatysite horizontali ir vertikali liniuotė nesimatytų dokumento: 

 

 

Iliustracija 3: The Ruler feature of Microsoft Word 

3.1.1.6 Teksto sritis 
Tekstas plotas yra pagrindinis langas atitinkantis išspausdintame puslapyje. Jūs renkate dokumentą į 
teksto laukelį. Mirksi vertikali linija viršutiniame kairiajame kampe teksto srityje yra žymeklis. 4 
paveiksle matyti teksto sritį Microsoft Word (¶ yra simbolis punktas).Mirksi vertikali juosta žymi 
esamą įterpimo tašką. Kaip rašote, jūsų tekstas rodomas į žymeklio vietą.Horizontali linija šalia 
žymeklio žymi dokumento pabaigą 
.  
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Iliustracija 4: The Text Area in Microsoft Office 

3.1.1.7 Būsenos juosta 
Iliustracija 5 rodo būsenos juostoje meniu. Jūs galite pakeisti tai, kas rodoma būsenos juostoje 

dešiniuoju pelės klavišu ant būsenos juostoje ir pasirinkite norimas parinktis iš Tinkinti būsenos 

juostoje meniu.u. 

 
Iliustracija 5: The Status Bar Menu in Microsoft Word 



 
 
ViPi Project 511792-LLP-1-2010-1-GR-KA3-KA3NW  
 

www.vipi-project.eu Page 9 

3.1.1.8 Dokumento peržiūra  
Programoje "Word" galite rodyti savo dokumentą į vieną iš penkių views: projektą, tinklo išdėstymą, 
Print Layout Skaitymo visame ekrane arba internetu Maketas.  
1. Projektas vaizdas: Galite naudoti vaizdą projektas greitai redaguoti dokumentą (vaizdai nerodomi).  
2. Interneto Išdėstymas: Web maketo rodinys leidžia jums peržiūrėti savo dokumentą kaip atrodytų 
naršyklėje, pavyzdžiui, Internet Explorer.  
3. Spausdinti Išdėstymas: Spausdinimo maketo rodinys rodo dokumentą maždaug kaip atrodys 
atspausdinta.  
4. Skaitymas Išdėstymas: skaitymo maketo rodinio formatai ekraną, kad skaityti jūsų dokumentas 
patogesnis.  
5. Metmenų vaizdas: Metmenų vaizdas rodys struktūros forma dokumentą. Galite rodyti antraštes be 
teksto. Jei perkelsite antraštę pridedamas tekstas juda su juo. 

3.1.1.9 Nespausdinami simboliai 
Kai kurie ženklai, vadinami ne spausdinimo simbolių, nereikia spausdinti ir nebus rodomas jūsų 

spausdinto dokumento, bet turėti įtakos jūsų dokumento maketą. Pavyzdžiui, iliustracija 6, skaičius 1 

rodo pagrindiniame puslapyje savybes ir skaičius 2 rodo pastraipos žymę (¶). Paspaudę šią straipsnio 

dalį mygtuką MARK perjungia tarp pastraipų įspaudai matomas ar paslėptas ekrano rodinyj. 

 

Iliustracija 6: Nonprinting Characters in Microsoft Word 

3.1.1.10 Paprasto duomenų rinkinio sukūrimas ir teksto 

pažymėjimas   
 

Jei įvesite = rand () į savo Word dokumentą ir tada paspauskite Enter, Word sukuria tris "konservai-

Text" pastraipas. Galite naudoti šias pastraipas praktiškai tai, ką jūs išmoksite. 

3.1.1.11 Kursoriaus valdymas  
 

Jūs galite perkelti žymeklį į nurodytą vietą paspausdami kairiuoju pelės klavišu su pele arba rodyklių 

klavišus judėti į nurodytą vietą.  
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3.1.1.12 Trumposios nuorodos skirtos vykdomosioms 

komandoms 
 

Kai naudojate programą Word, galite atlikti užduotis per įvairius metodus.Labiausiai paplitęs yra 

pasirinkti variantą spustelėję parinktį juostelę. Tačiau, jūs taip pat galite naudoti sparčiuosius 

klavišus.Vardas rakto po pliuso ir raidė reiškia, laikykite nuspaudę klavišą paspaudus raidė. 

3.1.2 Microsoft Office Word pagrindinės funkcijos 

3.1.2.1 Spausdinti, nutrinti ir ištrinti  
Microsoft Word ", galite kurti dokumentus, rašyti juos. Pavyzdžiui, jei norite sukurti naują failą 

atidarote "Microsoft Word" ir tada pradėti rašyti. Kai jūsų tekstas pasiekia linijos galą, "Microsoft 

Word" perkelia tekstą į naują eilutę. Jei norite pradėti naują pastraipą po to paspauskite klavišą 

enter. Jei norite ištrinti, naudokite Backspace klavišą. Kiekvieną kartą, kai jūs paspauskite grįžties 

klavišą, "Microsoft Word" ištrina simbolį, kuris prieš pateikiant žymeklį.Žymeklis yra taškas, kuriame 

pelės kursorius yra. Kitas būdas ištrinti tekstą yra naudoti klavišą Delete, pasirinkdami pirmiausia 

tekstą, kurį norite pasirinkti, o tada paspauskite klavišą DELETE. Jei turite grįžties klavišą bus ištrinti 

raides po vieną, kol ji bus išleista. 

3.1.2.2 Įterpti arba rašyti ant viršaus  
Įterpti režimas įterpia tekstą tarp teksto už ir prieš įterpimo punkto tekstas. Overtype režimas raides 

virš raidžių, kurios jau prieš įterpimo tašką.  

Siekiant, kad yra įterpti / Overtype mygtuką būsenos juostoje galite atlikti šiuos veiksmus:  

1. Dešiniuoju pelės mygtuku spustelėkite būsenos juostoje. Atrodo Tinkinti Statusas Baras meniu.  

2. Spauskite Overtype. Būsenos juostoje pasirodo Įterpti / Overtype mygtuką.  

3. Jei žodis Įterpti būsenos juostoje pasirodo, esate Įterpti režimu.  

4. Jei žodis Overtype būsenos juostoje pasirodo, spustelėkite žodį Overtype ir jis pasikeis į Įterpti, 

todėl keičiant žodį įterpti režimą. 

3.1.2.3 Dokumento išsaugojimas ir uždarymas  
Jei norite atšaukti savo dokumentą ir / ar dokumentus, vėliau turite i ¹ saugoti juos naudojant 

Išsaugoti variantas "Microsoft Office" meniu. Kitas taupymo dokumentą alternatyva įvesdami Ctrl + S. 

Kai įrašote pirmą kartą dokumentą, dialogo langas su pavadinimu "Save As" atrodo. Jūs galite naudoti 

šį dialogo langą rasti savo dokumentą į aplanką, kad jūs pageidaujate, ir pateikti savo dokumento 

pavadinimą. Po įrašėte savo dokumentą bent kartą, galite įrašyti bet kokius pakeitimus spustelėdami 

"Išsaugoti".  

3.1.2.4 Dokumento atidarymas 
Tarkime, kad jūs neturite laiko, kad užbaigtų savo darbą, jūs turite išsaugoti jį ir uždarykite failą. 

Vėliau galite atidaryti jį peržiūrėti arba jį baigti. Tiksliau, norint atidaryti failą, kurį išsaugojote jūs 

turite sekti tolesnius veiksmus:  
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1. Atidarykite Word 2010.  

2. Spustelėkite Microsoft Office mygtuką. Pasirodo meniu.  

3. Spustelėkite "Atidaryti". Pasirodo "Atidaryti dialogo" langas.  

4. Naudokite "Ieškoti" lauką pereiti į aplanką, kuriame įrašėte failą.Failas pavadintas "Pamoka 

Two.docx".  

5. Spauskite "Pamoka Two.docx".  

6. Spustelėkite "Atidaryti". Pasirodo failą, kurį sukūrėte per praėjusius pamoką.  

Alternatyvus metodas atidaryti failą naudoti raktus, ty paspauskite Ctrl + O arba dukart spustelėkite 

ant "Windows Explorer" failo. 

3.1.2.5 Iškirpti ir įklijuoti  
Galite pašalinti informaciją iš dokumento ir įdėkite jį bet kur tų pačių ar skirtingų dokumentų per 

"iškirpti ir įklijuoti" funkcijas. Office mainų sritis yra sandėliavimo plotas. Kai atmeti Word saugo 

duomenis, kuriuos supjaustyti į mainų sritį. Galite įterpti informaciją, kuri yra saugoma krepšyje taip 

dažnai, kaip jums patinka. 

.  

3.1.2.6 Iškarpinės naudojimas  
Kiekvieną kartą, jums iškirpti arba kopijuoti Word parduotuvių hierarchiškai šią informaciją į mainų 

sritį. Kai pasirenkate "Paste", prie hierarchijos viršūnėje punktas yra punktas Word pastos į savo 

dokumentą.Mainų gali saugoti iki 24 punktų. Galite įklijuoti kokią nors prekę į iškarpinę į dokumentą 

pateikimo žymeklį į įterpimo taško, rodyti Mainų sritį, o tada spustelėdami elementą.  

Mainų sritis apima mygtuką Parinktys. Galite spustelėti mygtuką Parinktys nustatyti Mainų galimybes 

aprašytus 

 Lentelė 1. 

pasirinkimas  
Rodyti Office mainų sritis automatiškai  
Rodyti Office mainų sritis Kai CTRL + C, du 
kartus Presuotos  
Rinkti nerodant Office mainų sritį  
Rodyti Office mainų srities piktograma 
užduočių juostoje  
Rodyti Statusas Netoli užduočių 
Kopijuojant 
 

aprašymas  
Automatiškai rodo Mainų kai kopijuojate 
elementus.  
Rodo Mainų Paspaudus CTRL + C, du kartus.  
Kopijuoja į mainų sritį, nerodant Mainų sritis 
sritį.  
Rodo Mainų piktogramą sistemos užduočių 
juostoje.  
Rodo daiktų nukopijuotų užduočių juostoje, kai 
kopijuojate skaičių. 

Lentelė 1: The clipboard pane functionality in Microsoft Word 

3.1.2.7 Gramatikos tikrinimo naudojimas  
Kaip įvedate žodis tikrina rašybą ir gramatiką. Rašybos klaidos rodyti su raudonu banguota linija pagal 

žodžio. Gramatikos klaidos rodyti su žalia banguota linija pagal klaidos. "Word 2007" suteikia jums 

galimybes peržiūrėti rašybos ir gramatikos klaidų dokumentus naudodami peržiūros skirtuko Rašyba 

ir gramatika mygtuką. 
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3.1.2.8 Rasti ir pakeisti funkcija 
Jei dirbate su dideliais failais ir norite ieškoti atskirų žodžių, galite naudoti komandą Rasti. Vykdant šią 

komandą rasite konkrečius žodžius ar frazes, jūsų dokumente. Tačiau, jei norite apriboti jūsų paiešką 

iki pasirinktos srities, pasirinkite tą erdvę ir tada vykdyti komandą Rasti.  

3.1.2.9 Pakeisti teksto formatavimą 
Ši funkcija leidžia jums pakeisti šriftą į įterpimo taško dokumento arba, tiesą sakant, pakeisti šriftą bet 

pažymėto teksto dydį (kaip parodyta iliustracija 7).  

Tai leidžia pateikti į savo dokumentus įvairių išvaizda ir stilių tekstus. Norėdami pakeisti šrifto dydį ar 

tipą:  

1. Pažymėkite tekstą, kurį norite taikyti kitokį šriftą. Tai gali būti bet kokio teksto kiekis dokumente iš 

vieno simbolio, žodžio, sakinio, pastraipos, ar visą dokumentą.  

2.Greitas būdas pakeisti šriftą ar dydį yra naudoti Formatavimo įrankių juostoje piktogramos (naudoti 

dešiniuoju pelės mygtuku spustelėkite, kad būtų rodomas šis) 

   
Iliustracija 7: Text Formatting in Microsoft Word 

3.1.2.10 Šriftų rinkmenos naudojimas  
Iš meniu Formatavimas pasirinkite Šrifto komandą kaip parodyta iliustracija 8. Rodomas dialogo 
langas Šriftas. 



 
 
ViPi Project 511792-LLP-1-2010-1-GR-KA3-KA3NW  
 

www.vipi-project.eu Page 13 

 

 

Iliustracija 8: The Font Command 

• Šriftas : Taip pat vadinamasšrifto , nurodo bendrą išvaizdą simbolių rinkinį . 
• Šrifto stilius : Nustato akcentuojant simbolį , ty paryškintai arba kursyvu . 
• Svoris: Nustato punktuose pobūdžio dydį. 
• Pabrauktas : Nustato pabraukimas stilių. 
• Spalva: Nustato teksto spalvą . 
• Perbrauktasperbraukti brėžiama per pasirinktų simbolių. 
• Dvigubas Perbrauktas : Du perbrauktoji linijos yra sudarytas pagal pasirinktus simbolių. 
• Viršutinis : tekstas yra pakeltas virš jo įprastą padėtį dėl teksto eilutę. 
• Apatinis : Tekstas yra nuleista žemiau savo įprastą poziciją dėl teksto eilutę. 
• Šešėlis : Prideda už teksto šešėlį. 
• metmenys : Rodo vidinė ir išorinė sienas kiekvieną simbolį . 
• išspausti : Tekstas atrodo pakeltas nuo puslapio reljefo . 
• graviruoti : pasirodo tekstas turi būti išspausdintas arba presuoti į puslapį . 
• Maži dangteliai: tekstas suformatuotas mažomis didžiosiomis raidėmis. 
• Visi rinktinėje: Visas tekstas suformatuotas didžiosiomis raidėmis. 
• Paslėpta : Veikėjai yra paslėpta puslapyje.. 

 

3.1.2.11 Teksto formatavimo naudojimas  
Norėdami formatuoti pažymėtą tekstą paryškinti, kursyvu ar pabraukti turite:  
1. Pažymėkite tekstą, kurį norite formatuoti kaip paryškintai, pasvirusiomis raidėmis, arba pabrėžti.  
Spauskite Bold arba Italic piktogramą () arba pabraukimo piktogramą () į Formatavimo įrankių 
juostoje  
Norėdami išjungti pasirinktas formatas vėl spustelėkite atitinkamą piktogramą įrankių juostoje 
Formatavimas. 
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3.1.2.12 Peržiūrėti ir spausdinti 
Spaudinio peržiūros funkcija naudinga peržiūrėti dokumentą prieš spausdinant. Taip pat galite 

spausdinti tiesiogiai iš spaudinio peržiūros ekrane. Spausdinti peržiūrėti dokumentą tolesni veiksmai 

turėtų būti laikomasi:  

1. Spustelėkite "Office" mygtuką  

2. Peržiūra ir spausdinti dokumento submeniu, spustelėkite Spaudinio peržiūra  

3. Norėdami grįžti į dokumentą be spausdinimo, ant spaudinio peržiūros komandų skirtuką, 

spustelėkite Uždaryti Print Preview (Spausdinimo peržiūra užsidaro).  

4. Spausdinti ant spausdinimo peržiūros komandų skirtuko Spausdinti grupėje PRINT  

5. Iš vardas išskleidžiamajame sąraše pasirinkite norimą spausdintuvą  

6. Puslapio nuotolio ir kopijas skyriuose, atlikite norimus pasirinkimus  

7. Spausdinti savo dokumentą, spustelėkite Gerai 

3.1.3 LibreOffice Writer  
 

LibreOffice Writer yra žodis procesorius su panašiu funkcionalumu ir failų palaikymas su Microsoft 

Word arba WordPerfect. Rašytojas yra funkcija turtingas įrankis kurti laiškus, knygos, ataskaitos, 

informaciniai biuleteniai, brošiūros, ir kitus dokumentus. Galite įterpti grafikos ir objektus iš kitų 

komponentų į Writer dokumentus. Rašytojas gali eksportuoti failus į HTML, XHTML, XML, Adobe 

Porlentelė Document Format (PDF), Daisy ir Brailio ir kelios versijos "Microsoft Word" failus.  

  Norėdami pradėti Rašytojas, kaip jis rodomas iliustracija 9, jūs turite eiti į LibreOffice Pradėti centras 

ir pasirinkite "Teksto dokumentas”.  
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Iliustracija 9: Launching Writer 

Jei norite sukurti naują dokumentą turite pradėti rašytojas ir tuščias dokumentas yra sukurta, laikinai 

pavadintas Untitled1 kaip parodyta iliustracija 10. Dėl naujo dokumento, jūs turite eiti į File> New 

"meniu juostoje ir jis bus sukurtas ir automatiškai pavadintas Untitled2 (). Galite pakartoti šį veiksmą 

tiek kartų, kiek naujų dokumentų reikia (iliustracija 11).  

 

Iliustracija 10: Creating new documents in LibreOffice 

 

Iliustracija 11: Creating multiple documents in LibreOffice 
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Šiame naujame dokumente, kaip tai parodyta iliustracija 12 galite įvesti tekstą ir taikyti įvairius 

formatus, jai naudojant įrankius matyti ant įrankių juostos ir meniu: bold (iliustracija 13), kursyvas, 

pabrauktas, šrifto spalvą ir įvairių rūšių derinimą.  

 

Iliustracija 12: A new document in LibreOffice 

 

Iliustracija 13: Applying different formats (bold in the example) in LibreOffice 

Tarkime, kad po to, kai baigsite kurti arba redaguoti dokumentą, kurį norite išsaugoti. Eikite į File → 

Save.Kaip dialogo Explorer atvers kaip parodyta Iliustracija 14 
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Iliustracija 14: Saving a document in LIbreOffice 

Čia galite naršyti vietą ir įveskite pavadinimą.Įvairių formatų, pavyzdžiui,. Dok. Txt ir gimtąja. ODT. yra 

teikiamos. Be kita taupymo galimybė nėra numatyta: "Išsaugoti kaip", kad nuves jus į Explorer kaip 

dialogo vėl, kur jūs galite naršyti į aplanką, kuriame norite išsaugoti savo dokumento kopiją 

(Iliustracija 15).  

 

Iliustracija 15: The “Save As” option in LibreOffice 



 
 
ViPi Project 511792-LLP-1-2010-1-GR-KA3-KA3NW  
 

www.vipi-project.eu Page 18 

Norėdami įterpti paveikslėlį į dokumentą, eikite į Pradėti LibreOffice biuro ir pasirinkite "Teksto 

dokumentas", kaip jau parodyta iliustracija 9. Dabar atidarykite arba sukurkite naują dokumentą, 

kuriame norite įterpti paveikslėlį.Kitas žingsnis yra Įterpti → Picture → From File kaip parodyta 

Iliustracija 16.  

 

Iliustracija 16: Inserting an image in LibreOffice 

The Insert picture dialog will open and you can select the image file you want to insert. Browse to it, 

select it and then click Open. 

 

Iliustracija 17: The insert picture dialog 



 
 
ViPi Project 511792-LLP-1-2010-1-GR-KA3-KA3NW  
 

www.vipi-project.eu Page 19 

3.2 Ofiso programos – skaičiuoklė 

3.2.1 Microsoft Office Excel pagrindai 
Segtuvas yra labai didelė lentelė, sudaryta iš eilučių ir stulpelių, kai duomenys gali būti įrašytas 

vadinamas darbalapyje kaip parodyta iliustracija 18. Užduotys, savo ruožtu, yra grupuojamas į 

darbaknygės. Pagal numatytuosius parametrus kiekvienas Excel darbaknygėje yra 3 lapus, kurios 

identifikuojamos pagal rodomų skirtukų išilgai ekrano apačioje. Tai identifikuoti atskirus lapus 

sudarančius darbaknygę. Pagal nutylėjimą pirmasis darbalapis vadinamas Sheet1, šalia yra Sheet2 ir 

tt. 

 
 

Iliustracija 18 : The worksheet in Microsoft Office Excel 

To start Excel () using the Windows Start menu: 

1. Click on the Start icon to display the Start menu and then move the mouse pointer onto All 
Programs. 

2. From the sub-menu select Microsoft Excel. 

 

Iliustracija 19:  Starting Microsoft Excel 

Yra keletas pasirinkimų, kaip mesti Excel (uždaryti programą):  

1. Spustelėkite Office mygtuką, po kurio išėjimo Excel mygtuką.  

2. Paspauskite Alt + F4 funkcinį klavišą.  

Spauskite ant Excel Uždaryti piktogramą  
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Norėdami atidaryti esamą darbo knygą iš meniu Failas, pasirinkite "Atidaryti", arba spustelėkite 

"Atidaryti" piktogramą Standartinėje įrankių juostoje.  

Norėdami uždaryti darbinį darbo grupę, pasirinkite Uždaryti meniu Failas. Atkreipkite dėmesį, kad: 

Jūsų bus paprašyta jei norite išsaugoti pakeitimus, kuriuos atlikote į failą. Pasirinkite Taip, jei norite 

išsaugoti, arba Ne, jei norite ignoruoti pokyčius 

 (Iliustracija 20). 

 

 
Iliustracija 20: Saving files in Microsoft Word 

3.2.1.1 Stulpeliai 
Norėdami sukurti sąrašo tipą, kaip minėta, "Microsoft Excel pateikia gatavą išdėstymas 
stulpeliais. Lengvai identifikuoti kiekvieną kategoriją sąraše, stulpelyje yra sukurta kaip 
vertikalus objektas. Ant kiekvieno stulpelio, yra (mėlyna) juosta vadinama stulpelio antraštė, 
kaip jis rodomas iliustracija 21. Kaip matyti iš ankstesnės pamokos, stulpeliai organizuojamas 
kaip (mėlyna) barų eilės 
: 

 

Iliustracija 21:  Organised columns in Microsoft Excel 

Kad būtų galima atskirti kiekvieno stulpelio, ji turi pavadinimą.Kolonėlės pavadinimas rodo stulpelio 

antraštę.Pavadinimas naudoja vieną, du, arba trys raidės.Kairiausias stulpelis yra pažymėtas, A. 

antrasis turi B etiketę, ir tt. 

3.2.1.2 Eilutės  
That would be galima atskirti kiekvieno stulpelio, JI must pavadinimą.Kolonėlės pavadinimas Rodo 

stulpelio antraštę.Pavadinimas naudoja Viena, du, Arba Trys raidės.Kairiausias stulpelis yra 

pažymėtas, A. antrasis must B etiketę ir tt.: 
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Iliustracija 22: Labelled rows in Microsoft Excel 

3.2.1.3 Ląstelės 
Each cell can be identified by its column letter and row number (Iliustracija 23). The selected cell is 

shown with a bold outline and the column and row headers highlighted in yellow. 

 

Iliustracija 23:  A spreadsheet showing cell B9 selected 
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3.2.2 Skaičiuoklės dokumento formatavimas   

3.2.2.1 Skaičių įrašymas 
 

1. 1. Pažymėkite langelį, kuriame norite įvesti numerį ir įveskite numerį. Jei norite, kad skaičius 
neigiamas, įveskite minuso ženklą priešais jį arba pridėkite ją skliaustuose (pvz. 
skliausteliuose).  
2. Nurodyti skaičiai po kablelio, įveskite visiškai sustabdyti ar kablelį, priklausomai nuo 
nustatymų.  
3. Numeriai bus sulygiuoti prie dešiniojo krašto pagal nutylėjimą. Jei norite įvesti skaičių ar 
formulę kaip tekstą įveskite kabutes (') prieš jį. 

3.2.2.2 Datos ir laiko įrašymas 
1. 1. Pažymėkite langelį, kuriame norite įvesti datą ir laiką ir tada įveskite datą arba laiką. 

Atskirkite pasimatymą su brūkšnių ar nerijos ribos  
2. Norėdami įvesti esamą datą naudoti mygtuko insulto CTR + kabliataškiu, o įvesti esamą 
laiką, naudokite klavišų kombinaciją CTRL + SHIFT + kabliataškiu 

3.2.2.3 Teksto įrašymas į ląstelę 
1. 1. Tiesiog spustelėkite langelį ir pradėkite rašyti tekstą, kurį norite įtraukti į tame langelyje  

2. Norėdami pereiti į kitą langelį Naudokite TAB mygtuką. Judėti žemyn mobilųjį paspauskite 
Enter. 

3.2.2.4 Duomenų formatavimas 
Įdėkite papildomų ląstelių turinį, pakeičia esamą mobilųjį turinį  

Paspauskite ant langelio, kuriame yra duomenys, kuriuos norite pakeisti. Pateiktame pavyzdyje 

(iliustracija 24), mes paspaudėte A2 langelyje, kuriame yra teksto abonementai 2002. 

 

 

Iliustracija 24: Changing the data in cell content 

1. Jei mes norėjome pakeisti į pasirinktą narvelį iš sąskaitų duomenis 2002 , į sąskaitų už 2003 , 
mes turime dvi alternatyvas: 
1 . Spustelėkite redagavimo juostoje link ekrano viršuje , kur galėsite pamatyti pasirinkto 
langelio dubliuoti turinį ir čia galite atlikti pakeitimus , arba 
2 . Dukart spustelėkite į " redagavimo vietoje " ant langelio , kuriame yra duomenys, kuriuos 
norite redaguoti, ir tada redaguoti duomenis tiesiogiai toje ląstelėje. 
Pakeisti esamas langelių turinį 
1 . Paspauskite ant langelio turinį , kurį nori pakeisti . 
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2 . Įrašykite naujus duomenis irduomenis įvesti automatiškai pakeisti esamą turinį . 
Pridėti sienas 
Taikyti sieną į langelių diapazoną , kaip jis rodomas iliustracija 25 ( naudoti pasienio 
piktogramą ) : 
1 . Pasirinkite langelį (-ius) , kurį norite pridėti kraštinę ( vilkdami pele arba naudojant Shift su 
rodyklių klavišus ) 
2 . Norėdami peržiūrėti pasienio parinktis, spustelėkite rodyklę žemyn šalia sienų piktogramą 
įrankių juostoje Formatavimas 
3 . Pasirinkite parinktį jums reikia. Pridėję sieną naudojant sienų piktogramąsienos 
pasirinkote pasirodys sienų piktogramą. Jūs galite pridėti tą pačią sieną , tiesiog paspaudę ant 
nuorodos po Pasirinkę langelį (-ius) , kurį norite taikyti sieną. 

 
 

 

Iliustracija 25: Apply borders to a cell range 

Sukurti įvairių tipų diagramas / grafikus iš skaičiuoklės duomenų  

Pažymėkite langelius, kuriuos norite įtraukti į diagramą. Jei norite pabrėžti ne vientisą asortimentą, 

pažymėkite pirmąjį asortimentą su pele, laikykite nuspaudę Ctrl klavišą ir paspauskite ant bet kurių 

kitų ląstelių.  

Įterpti įrankių juostoje, spustelėkite ant reikiamo diagrama piktogramos (nuo stulpelio, linijos, 

pyragas, baras, sritis, sklaida ir kita) (iliustracija 26). Arba spustelėkite mažą rodyklę topų skyriuje 

įrašyti juostelės apačioje atskleisti dialogą Iliustracija 27. 

        

Iliustracija 26: Chart icons in the Insert menu 
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Iliustracija 27: The Chart type feature 

You can then edit the chart using the settings in the Design, Layout and Format tabs of the Chart 

Tools as shown in Iliustracija 28 to Iliustracija 30. 

 

Iliustracija 28: The design tab 
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Iliustracija 29: The Layout tab 

 

Iliustracija 30: The Format tab 

These tabs provide all the functionality to fully edit the charts. 

3.2.2.5 Pagrindinių formulių naudojimas 
sukurti formules  

Norėdami sukurti formules naudojant langelių nuorodas ir aritmetinius operatorius:  

1. Perkelkite žymeklį į langelį, kur formulė bus rodomas.  

2. Įveskite "=" (vienodas) ženklą.  

3. Įveskite išraišką, kuri gamins norimą rezultatą. Tai gali būti sudarytas iš operandų, vertybių, 

kintamųjų ir simbolių, kurie sudaro matematinių procedūrų (tokių kaip "= A5 + E5" už pridedant 

langelyje A5 turinį E5).  

 

Jūs galite naudoti šiuos simbolius: 
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Kai formulė yra baigtas, paspauskite Enter. Formulės rezultatas bus skaičiuojamas ir rodomas 
langelyje.  
Galite rodyti pačią formulę Formulės juostoje ekrano viršuje pateikimo mobilųjį žymeklį ant langelio. 
Jei yra formulėje klaida, rodomas klaidos pranešimas, kuris prasidės # ženklu.  
Įveskite langelio ar diapazono nuorodą, nurodydami  
1. Įveskite formulę up į langelį arba diapazoną atskaitos taškas, pvz įveskite formulę = E2 + E5 tik 
įvesti vienodą (=) ženklo.  
2. Perkelkite žymeklį į mobilųjį pirmąjį langelio nuorodą naudodami rodyklių klavišus.Formulė bus 
stebėti savo pažangą ir įveskite dabartinį adresą į formulę.  
3. Paspauskite "Enter", kad užbaigtumėte formulę, kai jūs pasiekėte langelį jums reikia. 
 

3.2.3 LibreOffice Calc  
Calc -  yra skaičiuoklės komponento LibreOffice (iliustracija 31), panašus į "Microsoft Excel" arba 

"Lotus 1-2-3. Ji turi unikalių bruožų, įskaitant sistemos, kuri automatiškai apibrėžia serijos grafikus, 

remiantis turimais vartotojui informaciją. 

 

Iliustracija 31: The spreadsheet of LibreOffice 

To open Calc you have to select the “Spreadsheet” from the options. The main components of Calc: 

contain a gird of cells, the tools organized in toolbars, the menus in the menu bar and the sheet 

labels.   
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Iliustracija 32: The main components of Calc in LibreOffice 

The Format Cells dialog box is very important because it provides you with the options to apply the 

“Date” format and all numerical data will be treated as date in the selected format. 

 

Iliustracija 33: The Format Cells dialog box 

Kitos funkcijos , kurias teikia skaičiuoklė apima: 

• Funkcijos , kurios gali būti naudojamos sukurti formules, atlikti sudėtingus skaičiavimus 

duomenimis 

• Duomenų bazės funkcijos , organizuoti , saugoti ir filtras duomenys 

• Dinaminis grafikus ;platus 2D ir 3D grafikai 

• makrokomandas , įrašymo ir vykdančiosios pasikartojančias užduotis ; remiami skriptų kalbos yra 

LibreOffice Basic , Python , beanshell ir JavaScript 
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• Galimybė atidaryti, redaguoti ir įrašyti "Microsoft Excel" skaičiuokles 

• Importo ir eksporto skaičiuoklės į daugelį formatų , įskaitant HTML , CSV , PDF ir PostScript 

Kai Kalkių yra pradėta,pagrindinis langas panašus į iliustracija 31 . Tiksliau : 

Pavadinimas baras įsikūrę viršuje, parodo dabartinę skaičiuoklę vardą . Kaiskaičiuoklės yra naujai 

įkurta, jos vardas yra Untitled X , kur X yraskaičius. Kai įrašote pirmą kartą skaičiuoklę , esate raginami 

įvesti pasirinktą pavadinimą. 

Pagal pavadinimo juostoje yrameniu juosta . Kai jūs pasirenkate vieną iš meniu ,submeniu ir kitų 

variantų. 

• Vaizdas yra komandos , kurios taikomos visam dokumentui , pavyzdžiui, atidaryti, išsaugoti Wizards 

, eksportuoti kaip PDF ir skaitmeninių parašų . 

• Redaguoti yra komandos redaguoti dokumentą , pvz Anuliuoti pokyčiai , palyginkite dokumentą, 

Radimas ir keitimas . 

• Temos yra komandos modifikavimo kaipkalkių vartotojo sąsaja atrodo , pavyzdžiui, įrankių juostos, 

visą ekraną, ir priartinti . 

• Įterpti yra komandos įterpti elementus, tokius kaip ląstelių, eilutės, stulpeliai , lakštų, ir nuotraukas į 

skaičiuoklę . 

• Formatas yra komandos modifikavimo skaičiuoklės , pavyzdžiui, stilių ir formatavimą, dalis 

išdėstymą ir Sujungti langelius . 

• Įrankiai yra funkcijų, pavyzdžiui, rašybos , Share dokumentas, Mobilaus ryšio turinį, galerija ir 

Makrokomandos . 

• Duomenų yra komandos manipuliuoti duomenis savo skaičiuoklę , pvz Nustatykite intervalą , 

rūšiuoti, filtruoti , ir DataPilot . 

• Langų pateikta komandas ekrano lange , pavyzdžiui, naujame lange , Splitas, ir užšaldyti . 

• Pagalba pateikiamos nuorodos į žinyno faile siejama su programine įranga , Kas tai yra ? , Pagalba, 

registracija, ir patikrinkite , ar yra naujinimų . 

Kalkių turi kelias rūšis įrankių juostos : nukirpta (Fixed vietoje ), plaukiojantieji ir nuplėšiamu . 

Nukirpta įrankių juostos gali būti perkeltas į skirtingose vietose arba pagaminti plaukti , ir 

plaukiojantieji įrankių juostos gali būti nukirpta . Keturi įrankių juostos yra po meniu juostoje pagal 

nutylėjimą :Standartinėje įrankių juostoje ,įrankių juostos ieškomą ,Formatavimo įrankių juostoje , 

irformulės juostoje . 

Rodyti arba paslėpti įrankių juostas : jei norite rodyti arba paslėpti įrankių juostas , pasirinkite 

Rodymas → Toolbars , tada paspauskite ant įrankių juostos sąrašo pavadinimą. Aktyvi įrankių juosta 

rodo varnelę šalia jo pavadinimo . Nuplėšiami įrankių juostos nėra įtrauktos į meniu Rodymas. 

Padėklai ir nuplėšiamu įrankių : įrankių juostos piktogramos su mažu trikampiu dešinėje bus rodomas 

paletes , Nuplėšiami įrankių juostų ir kitų būdų, pasirinkdami dalykus , priklausomai nuo piktogramos. 

Iš paletės pavyzdys pateiktas žemiau iliustracija 

:  

 

Iliustracija 34: An example of a palette in LibreOffice Calc 
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Persikėlimas įrankių: Norėdami perkelti prijungtą įrankių juostą, užveskite pelės žymiklį virš įrankių 

juostos rankena, laikykite nuspaudę kairįjį pelės mygtuką, vilkite įrankių juostą į naują vietą, ir tada 

atleiskite pelės mygtuką iliustracija 35. Norėdami perkelti slankiąją įrankių juostą, spustelėkite jos 

pavadinimą ir vilkite jį į naują vietą Iliustracija 36.  

 

Iliustracija 35: Moving Toolbars in Calc 

 

Iliustracija 36: Moving a floating toolbar 

Docking / plaukiojantieji langai ir įrankių juostos: Įrankių juostos ir kai kurie langai, pvz Navigator 
Stiliai ir formatavimas lange, yra įtaisomas. Galite perkelti, pakeisti dydį, arba prijungti juos prie 
krašto.  
Dokas langą arba įrankių juostoje, laikykite nuspaudę Ctrl klavišą ir dukart spustelėkite ant 
plūduriuojančio lango rėmo.  
Norėdami oddokuj langą, laikykite nuspaudę Ctrl klavišą ir dukart paspauskite ant rėmo (arba laisvą 
plotą šalia viršuje piktogramų) iš įstatytas langas 
. 

 

Iliustracija 37: The Navigator window 

Customizing toolbars: To access a toolbar’s customization options, use the down-arrow at the end of 

the toolbar or on its title bar.  
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Iliustracija 38: Customizing toolbars 

You can also add icons and create new toolbars:  

 

Iliustracija 39: Selection of visible toolbar icons 

Formatting toolbar: In the Formatting toolbar, the three boxes on the left are the Apply Style, Font 

Name, and Font Size lists  

 

Iliustracija 40: The Formatting Toolbar 
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3.3 Office programos – skaidrių rodymo programa 

3.3.1 Kaip naudoti Microsoft Office PowerPoint 
PowerPoint pristatymas programinė įranga, kuri gali būti naudojama siekiant sukurti skaidrių peržiūrą 

spausdinimui, ekrano projekcija arba žiniatinklio ekran.  

3.3.1.1 PowerPoint atidarymas 
1. 1. Spustelėkite mygtuką Pradėti  

2. Spustelėkite Visos programos  
3. Spustelėkite "Microsoft Office" ir tada "Microsoft PowerPoint" variantas 

 

 
 

Iliustracija 41: Opening Microsoft PowerPoint 

3.3.1.2 PowerPoint programos uždarymas 
1. 1. Spauskite ant Uždaryti piktogramą (maža kryžminio viršuje dešinėje programos lango). Jei 

neišsaugoti pakeitimai buvo padaryti savo pristatymą dialogo langas, suteikiantis jums 
galimybę išsaugoti pateiktį kaip parodyta iliustracija 42, prieš uždarant programą. 

 

 
 

Iliustracija 42: Save the PowerPoint presentations 

2. Click Yes to save the presentation before closing OR click No to close without saving changes 
OR click on the Cancel button to cancel the operation. 
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3.3.1.3 Naujos prezentacijos kūrimas 
Pradėti PowerPoint. Kai "PowerPoint" yra atidaryta, Blankas Pavadinimas skaidrė pasirodo pagal 

nutylėjimą kaip pirmąją skaidrę savo naują pristatymą. Tai tuščias Pavadinimas skaidrė jūsų naują 

pristatymą pagrindas, kai jūs pirmą kartą atidarius PowerPoint "arba po" PowerPoint "jau atidarytas 

(iliustracija 43).  

Arba, jūs galite spustelėti ant naujos piktogramo. 

 

Iliustracija 43: Creating Presentations in PowerPoint 

3.3.1.4 Esamos prezentacijos atidarymas 
Spustelėkite Office mygtuką, tada Open meniu pasirinkimą.Dialogo lange Atidaryti rodomas. Jei failą, 
kurį norite atidaryti pateikta kitą aplanką ar diską, pereikite prie tos vietos, naudojant į išvaizdą: 
sąrašo lauke. Norėdami atidaryti failą, jums reikia, spustelėkite failą, pasirinkite jį ir paspauskite Open 
mygtuką.  
Galite naudoti piktogramas visoje Dialogo lange Atidaryti viršuje, kad padėtų jums rasti ir pasirinkti 

reikiamą failą (Iliustracija 44). 

 
 

Iliustracija 44: Locating and selecting files 

Spustelėkite rodyklę žemyn, kad būtų rodomas aplankų (katalogų) ir diskus.  
   Rodyti ankstesnius aplankus.  
  Spustelėkite čia norėdami pereiti vienu aplanko lygį katalogų medis.  
  Spauskite čia ieškoti internete.  
  Spauskite čia norėdami ištrinti pasirinktą failą.  
  Spauskite èia ir sukurkite naują aplanką pagal pasirinktą aplanką.  
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  Spustelėkite rodyklę žemyn, lašas šalia piktogramos pamatyti seleclentelė nuomonėmis sąrašą.  
Pakartotinai paspaudus šį piktograma ciklo per įvairias nuomonėmis. 
 

 

Iliustracija 45: The list of Tools seleclentelė views 

Norėdami atidaryti neseniai naudotą "PowerPoint" failą, jūs turite pasirinkti neseniai atidaryti failus 

pagal Office mygtuką sąrašą. Galite atidaryti šiuos failus, paspaudę ant jų.  

 

Iliustracija 46: Open a recently used PowerPoint files 

3.3.1.5 Antraštės ir paantraštės sukūrimas 

prezentacijoje  
Kai pirmą kartą atidaryti "PowerPoint", pamatysite tuščią "skaidrių" su pasiūlymu dėl pavadinimo ir 

paantraštės dviejų dėžių erdvėje. Šis puslapis bus pagrindas siekiant sukurti savo pristatymą. Jūs 

galite įdėti pavadinimą ir paantraštę į dėžutes, jei norite paspaudę viduje ir rašyti, bet galite juos 

ištrinti ir įrašyti viską, ką nori 

. 
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Iliustracija 47: A Title and a Subtitle of a Presentation 

3.3.1.6 Skaidrės turinio redagavimas 
 Norėdami redaguoti skaidrės turinį, jūs turite naudoti tuos pačius redagavimo metodus, kurie 

jums naudoti per žodis procesorius. Norėdami įterpti tekstą jūs turite paspausti taške, kurį 
norite įterpti tekstą ir pradėti rašyti.  
Jei norite perrašyti esamą tekstą, pažymėkite tekstą, kurį norite pakeisti nauju tekstu. 
Pradėkite įvedinėti ir naujas tekstas bus pakeisti seną tekstą.  
Norėdami redaguoti užrašus puslapius, naudokite tuos pačius metodus, kaip nurodyta 
pirmiau, ir redaguoti užrašus tekstą, kuris bus rodomas po įprastame rodinyje skaidrę.  
Norėdami įterpti paveikslėlį į skaidrę, turite:  
• Rodyti skaidrę per savo pristatymą.  
• Spustelėkite skirtuko Įterpimas meniu pasirinkite Picture komandą. Jei reikia pakeisti į 
reikiamą diską arba aplanką, tada pasirinkite norimą paveikslėlio failą. Jūs turėtumėte 
pamatyti pasirinkto vaizdo failo peržiūrą, kaip dialogo lange. 
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Iliustracija 48: Insert an image to your presentation 

Kai teisingai failas yra pažymėtas, spustelėkite mygtuką Įterpti ir vaizdas bus rodomas per savo 

skaidrę.  

Atkreipkite dėmesį, kad jei jūs spustelėkite rodyklę žemyn ir tipo skyriuje Dialogo lange Paveikslėlio 

įterpimas failus, pamatysite failų tipų sąrašą, kurį galite įterpti į savo pristatymą 

. 

 

Įvairios failų tipai, kuriuos galite įterpti savo pristatymą 

Jūs galite kopijuoti, perkelti ir ištrinti vaizdus beveik lygiai taip pat , kad galėtumėte manipuliuoti 

pasirinktą tekstą . Galite naudoti Drag and Drop metodus ar naudotis iškarpinę, kartu su Iškirpti, 

Kopijuoti ir Įklijuoti komandas. 

Norėdami nukopijuoti ir įklijuoti paveikslėlį , turite : 

 

• Pasirinkite atvaizdą , kurį norite kopijuoti į mainų sritį 

• Tada iš meniu Redagavimas pasirinkite komandą Kopijuoti arba paspauskite CTRL + C , perkelti 

vaizdą į mainų sritį nenuimant nuo skaidrės ar jūs taip pat galite naudoti kopijavimo piktogramą 

Standartinėje įrankių juostoje 

Kaivaizdas saugomi iškarpinę , padėkite žymeklį per skaidrę , toje vietoje, kurioje norite įterpti 
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paveikslėlį . Tada spustelėkite Įklijuoti piktogramą. Be to kopijuoti elementą iš vienos skaidrės į kitą 

pristatymą 

• Pažymėkite tekstą , paveikslėlį, sudarytą objektą ar diagramą , kurį norite kopijuoti . 

• Paspauskite Ctrl + C nukopijuoti pasirinktą elementą į mainų sritį. 

• NaudokiteKitas skaidrių / Atgal skaidrių kontroliuoja rodyti skaidrę , į kurią norite kopijuoti 

elementą 

 . 

 

Iliustracija 49: The Next Slide icon 

Jeielementas, kurį nukopijuoti į mainų sritį buvo tekstas , spustelėkite viduje toje vietoje, kurioje 

norite įklijuoti tekstą skaidrėje , ar dar tiesiog įklijuoti elementą į skaidrę . Atminkite, kadSpartieji 

klaviatūros klavišai Norėdami įklijuoti yra CTRL + V. Jeiprekės buvo ne tekstas , jums gali tekti naudoti 

įprastas " Drag and Drop " metodus perkelti elementą į skaidrę. 

Norėdami kopijuoti elementą iš vienos pristatymo skaidrės į per skirtingų pristatymo skaidrės : 

• Pažymėkite tekstą , paveikslėlį, sudarytą objektą ar diagramą , kurį norite kopijuoti . 

• Paspauskite Ctrl + C nukopijuoti pasirinktą elementą į mainų sritį. 

• Pasirinkite kitą , atvirą "PowerPoint" pateiktį , į kurią norite įklijuoti nukopijuotą elementą. 

 

Jei būtina, per šio antrojo pristatymo , naudokite kitą skaidrę / Atgal skaidrę kontroliuoja rodyti 

skaidrę , į kurią norite kopijuoti elementą. 

Jeielementas, kurį nukopijuoti į mainų sritį buvo tekstas , spustelėkite viduje toje vietoje, kurioje 

norite įklijuoti tekstą skaidrėje , ar dar tiesiog įklijuoti elementą į skaidrę . Atminkite, kadSpartieji 

klaviatūros klavišai Norėdami įklijuoti yra CTRL + V. Jeiprekės buvo ne tekstas , jums gali tekti naudoti 

įprastas " Drag and Drop " metodus perkelti elementą į skaidrę. 

Norėdami kopijuoti iš vienos vietos į kitą skaidrę per pristatymą : 

• Spustelėkite Pristatymas rūšiuotuvas Peržiūrėti piktogramos 

• Pasirinkite skaidrę , kurį norite kopijuoti . 

• Paspauskite Ctrl + C nukopijuokite visą skaidrę į mainų sritį. 

• Paspauskite tarp dviejų skaidrių , kur nori įklijuokite nukopijuotą skaidrę (plona vertikali linija žymi 

įterpimo tašką už jus) 

• Paspauskite Ctrl + V įklijuokite nukopijuotą skaidrę 

. 

 

Iliustracija 50: The Slide Sorter View 
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Norėdami nukopijuoti per vieną pristatymą skaidrę į skaidrę per kitą pristatymą : 

• Spustelėkite Pristatymas rūšiuotuvas Peržiūrėti piktogramos (apačioje kairėje) 

• Pasirinkite skaidrę , kurį norite kopijuoti . 

• Paspauskite Ctrl + C nukopijuokite visą skaidrę į mainų sritį. 

• Paspauskite ant lango išskleidžiamajame meniu ir pasirinkite kitą , atvirą PowerPoint pristatymą , į 

kurį norite įklijuoti nukopijuotą skaidrę . 

• Spustelėkite Pristatymas rūšiuotuvas Peržiūrėti piktogramos ( apačioje kairėje) , kad antrojo 

pristatymo skaidres rodomi skaidrių rūšiavimo Atsižvelgiant . 

• Paspauskite tarp dviejų skaidrių , kur nori įklijuokite nukopijuotą skaidrę (plona vertikali linija žymi 

įterpimo tašką už jus) 

• Paspauskite Ctrl + V įklijuokite nukopijuotą skaidrę . 

 

Norėdami pakeisti fono spalvą pasirinktos skaidrės turite : 

 

• Spustelėkite Formatas išskleidžiamajame meniu ir pasirinkite Fono komandą . Tai bus rodomas 

dialogo langas . Pasirinkite norimą spalvą. 

• Norėdami taikyti šį fono spalvą į pasirinktą skaidrę , spustelėkite mygtuką "Apply" . 

• Norėdami taikyti šį fono spalvą visoms skaidrėms per pateikimo spustelėkiteTaikyti visiems 

mygtuką 

. 

 
 

Iliustracija 51: Change the background of a selected slide 

3.3.1.7 Šablonų ir temų naudojimas 
 Taikyti dizaino temą:  

• Rodyti pateiktį, į kurią norite taikyti dizaino temą.  
• Spustelėkite skirtuko Dizainas ir pasirinkite Ekrano temos submeniu, kuris bus rodomas 
galimų variantų. 
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Iliustracija 52: Applying a design theme  

Galiausiai, magistro šablonus iš esmės yra naudojamos sukurti naują pateiktį. Spustelėkite Office 
mygtuką, tada spustelėkite komandą Naujas.Naujas pristatymas užduočių srityje rodomas. Tada 
pasirinkite Installed Šablonai komandą. Jei ištirti kitas galimybes, pavyzdžiui, "Microsoft Office 
Online", pamatysite kitus turimus šablonus. Sunkus šablonus padėti jums nustatyti nuoseklią išvaizdą 
ir visais pristatymais. 

3.3.1.8 Pridėti medijų failą į skaidrę   
Jei norite, kad jūsų pateiktis negali būti statinis nejudančių vaizdų arba teksto, jūs galite pridėti 
pavyzdžiui, filmų ir garsų, kad jiems įdomesnis.  
Norėdami pridėti filmą, spustelėkite Įterpti iš PowerPoint skirtuko juostą viršuje ir pasirinkite filmą ar 
garso pamatyti 
pasirinktis:

 
 

Iliustracija 53: Insert movies and sound to your presentation 
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"PowerPoint", atrodo, suteikia Jums tam tikrą skaičių filmų formatus įterpti. Bet AVI ir MPEG video 

turėtų būti Gerai.  

Po naršyti jūsų vaizdo buvimo vietą, ir paspauskite Gerai, "PowerPoint" bus rodomas pranešimas,: 

 
 

 
 

Iliustracija 54: Select the options “yes or no” for playing or not the video at your slide 

If you prefer not to play the video as soon as the slide appears on screen, click No. You would then 

have to click on the video itself for it to play. 

3.3.1.9 Prezentacijos išsaugojimas 
1. Spustelėkite Office mygtuką, tada pasirinkite Išsaugoti kaip matyti dialogo langą Įrašyti kaip. 

Įsitikinkite, kad esate įsikūrę aplanko / disko pasirinktą spustelėję rodyklę Įrašyti dešinę 

išskleidžiamajame sąrašo lauke ir vykimą į jūsų reikalaujama vietą.  

2. Įveskite failo pavadinimą į teksto laukelyje Failo vardas. Failų negali būti bet kuris iš šių simbolių 

  

 
 

Iliustracija 55: Symbols that cannot be used as filenames 

1. Click the Save button to complete the file saving process. 
 

3.3.1.10 Prezentacijos uždarmas 
Paspaudus Office "mygtuką, pasirinkite Uždaryti meniu arba paspauskite ant Uždaryti rodomos 

piktogramos viršuje dešinėje pateikimo lange.  

Pristatymas bus uždaryta, o ekranas bus pašalinta. Jei bandysite uždaryti pristatymą be įrašydami jį, 

"PowerPoint" rodomas dialogo langas, raginantis išsaugoti bet pakeitimus, kuriuos padarė į 

pristatymą. 

3.3.2 Demonstracinės prezentacijos kūrimas 

3.3.2.1 Pridėti naują skaidrę su konkrečių šablonu 
Click on the New Slide icon.  
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Iliustracija 56: The New Slide icon 

From the Layout task pane, select the required slide layout (Iliustracija 57). 

 

Iliustracija 57: Slide Layout selections 

 
In the example illustrated, we selected the ‘Two Content’ slide layout. As you may see the slide is 

formatted accordingly (Iliustracija 58). 
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Iliustracija 58: Formatting a slide 

3.3.2.2 Pritaikyti skirtingus šablonus skaidrėje  
Rodyti skaidrę per pristatymą, kur norite keisti skaidrės maketą. Dešiniuoju pelės klavišu spustelėkite 

skaidrę ir iš kontekstinio meniu pasirinkite Layout komandą, nes ji yra pavaizduotaIliustracija 59. 

 

Iliustracija 59: Changing the Slide layout in PowerPoint 

This will display the Layout task pane and you could select the required slide layout. 
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3.3.2.3 Išsaugoti prezentaciją kitame formate 
1. Norėdami išsaugoti failą kitokiu formatu, nei "PowerPoint" formatu, pavyzdžiui, RTF:  

1. Nuo Office mygtuką galimų variantų, spauskite Save As komanda.  

2. Jei reikia, pasirinkite aplanką, kuriame norite išsaugoti failą Įrašyti į sąrašo lauką.  

3. Spustelėkite rodyklę žemyn į dešinę Save as type: laukelyje ir pasirinkite File formatu tipą, 

kurį norite išsaugoti failą kaip, pavyzdžiui, PDF, kaip parodyta  Iliustracija 60. 

 
Iliustracija 60: Saving a presentation in different file formats 

3.3.2.4 Išsaugoti blą, kaip PowerPoint šabloną 
Šablonas yra specialaus tipo failą, kuris gali būti sukurta kartą ir individualų, kaip reikalaujama. Tai 

tada gali būti perdirbamos vėl ir vėl (Iliustracija 61). 

 
Iliustracija 61: Save files as a PowerPoint Template 

3.3.2.5 Perjungimas tarp atidarytų prezentacijų   
Kiekvienas pristatymas, kurį atidaryti bus rodomas kaip per Windows užduočių juostoje piktogramą 
(rodomas išilgai ekrano apačioje), kaip pavaizduota.  
 

 
 

Iliustracija 62: Switching between different presentations 

To switch to the required presentation, you have to click on the icon.  

3.3.3 LibreOffice Impress 
Impress yra pristatymas redaktorius LibreOffice ir su juo galite sukurti skaidrių peržiūrą savo gimtąja 

formatai ODP ir ppt ir išsaugoti pristatymus PDF formatu lengvai dalintis. Jei įdiegėte LibreOffice, jūs 

turite pasirinkti "Presentation" parinktį pagrindiniame meniu:  
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Iliustracija 63: The presentation Option in LibreOffice 

Galite pradėti įspūdį keliais būdais:  

• Jei nė viena iš LibreOffice komponentas yra atvira, iš "Start" centro: spustelėkite Presentation 

piktogramą.  

• Nuo sistemos meniu arba LibreOffice Quickstarter. Informacija skirtis su savo operacinę sistemą; žr. 

1 skyriuje, pradžios vadovas, jei jums reikia daugiau informacijos.  

• Iš bet kurios atviros komponento LibreOffice: spauskite į Naujosios piktogramą pagrindinėje įrankių 

juostoje ir pasirinkite pristatymas iš išplečiamojo meniu dešinėje trikampis, arba pasirinkite File -> 

New-> pristatymas iš meniu juostos.  

Paleidus įspūdį pirmą kartą, pristatymas vedlys bus rodomas. Jei nenorite naudoti vedlį, kad ateityje 

galite pasirinkti Nerodyti šį vedlį dar kartą. Spustelėkite Kurti, kad atidarytumėte pagrindinį Impress 

langą. 
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Iliustracija 64: The Presentation Wizard Window 

In the next screen capture you´ll have to select among different presentation backgrounds 

(Iliustracija 65).   

 

Iliustracija 65: Select among different presentation backgrounds 

Select the create option a window with layouts options will open. Now you have to go to the Layouts 

task panel and select one of them, as it is shown in Iliustracija 66.  

 

Iliustracija 66: The Task panel of “Layouts” 

Pagrindinis įteigti langą sudaro trys dalys: Skaidres srityje darbo srities, ir Uždaviniai Pane. Galite 
pašalinti Slides sritį arba Uždaviniai Pane iš akiračio paspaudę X viršutiniame dešiniajame kampe 
kiekvieno srityje. Jūs taip pat galite rodyti arba slėpti šiuos stiklus naudodami Žiūrėti -> Slide sritį arba 
Rodyti -> Task Pane arba spustelėję Slėpti / Rodyti žymeklį ties viduriu vertikalią skyriklio linija 
(apjuosėme paveiksle). Pasislėpę šių sričių, galite padidinti darbo srities plotas 
. 
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Iliustracija 67: The main Impress Window 

Skaidrės sritis yra miniatiūras apie jūsų pateikties skaidrėse. Paspaudę šioje srityje skaidrę pasirenka jį 

ir skiria jį Workspace ". Kai skaidrės yra Workspace ", galite pakeisti bet kokiu būdu norite.  

• Uždaviniai Pane.Užduotys sritis turi penkis skyrius: Meistras puslapių maketų Lentelė dizainas, 

Pasirinktinės animacijos, Skaidrių perėjimas  

• Sunkus Puslapiai: Čia jūs nustatote puslapio stilių jūsų pristatymą.  

• Maketai: Galite pasirinkti vieną norite ir naudoti jį kaip ji yra, arba galite pakeisti jį patenkinti savo 

reikalavimus.  

• Lentelė dizainas: standartiniai lentelė stiliai šioje srityje teikiamas  

• Skaidrių perėjimas: Pristatymas Perėjimas skyriuje pateikiama prieigą prie skaidrių perėjimo 

galimybių.  

Darbo sritis (paprastai centre) turi penkis skirtukus, taip pat vadinamas Peržiūrėti mygtuka. 

 

Iliustracija 68: The Workspace’s menu 

Įrankių: Daugelis įrankių juostos gali būti naudojamas skaidrių kūrimo metu, jie gali būti rodomas 

arba nerodomas, paspauskite View> Toolbars ir pasirinkdami iš meniu.  

Būsenos juosta: Būsenos juostoje, esantis ties Impress lango apačioje, pateikiama informacija, kad 

jums gali rasti naudinga, kai darbo pristatymą.  

Navigatorius: navigatorius rodo visus objektus, esančius dokumente. Tai suteikia dar vieną patogų 

būdą judėti dokumentą ir rasti elementus jį.  
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Iliustracija 69: The Navigator functionality 

To enter some text, just follow the instructions into the box: “Click to add title” as it is shown in 

Iliustracija 70. 

 

Iliustracija 70: Adding title and text in a presentation in LibreOffice 

To insert images you have to create a new presentation and then create a blank slide as it is shown in 

Iliustracija 71, where you are going to inert the image which you have stores in your folders (i.e. your 

desktop or My Pictures folder, etc.).  
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Iliustracija 71: Inserting images in LibreOffice Impress 

Kai kuriate naują pateiktį, galite pridėti šiek tiek stilių į jį. Taigi, tarkime, jūs turite apačioje "The 

LibreOffice funkcijų" titulą ir norite pateikti jį labiau įspūdingas būdas. Norint tai pasiekti, eikite į 

kairiajame skydelyje ir spustelėkite Master Pages. Jis parodys jums galimus variantus, kaip parodyta 

Iliustracija 72:  

 

Iliustracija 72: The Master Pages options for applying styles in presentations 

Kai joks dokumentas yra atidarytas, Pradėti centras suteikia galimybę atidaryti esamą dokumentą 

arba pasirinkti iš neseniai redagavo dokumentų sąrašą piktogramą. 
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Iliustracija 73: Opening an existing document in LibreOffice 

Taip pat galite atidaryti esamą dokumentą vienu iš šių būdų.  

• Pasirinkite File → Open ...  

• Spauskite mygtuką Atidaryti pagrindinėje įrankių juostoje.  

• Paspauskite Ctrl + O ant klaviatūros.  

Kiekvienu atveju yra Atidaryti dialogo langą. Pasirinkite failą, kurį norite, ir spustelėkite Atidaryti. 

Norėdami uždaryti dokumentą, pasirinkite File → Close. Taip pat galite uždaryti dokumentą 

spustelėdami Uždaryti piktogramą dokumento lange.  

Norėdami uždaryti dokumentą, pasirinkite File → Close. Taip pat galite uždaryti dokumentą 

spustelėdami Uždaryti piktogramą dokumento lange. 

 

Iliustracija 74: The Close command in LibreOffice 

Jei daugiau nei vienas LibreOffice langas, kiekvienas langas atrodo mėginio parodyta kairėje. Jei yra 
tik vienas LibreOffice langas, atrodo mėginio parodyta dešinėje. Jei dokumentas nebuvo išgelbėtas 
nuo paskutinio pakeitimo, žinutė langas. Pasirinkite, ar norite i ¹ saugoti arba išmesti pakeitimus.  
• sutaupote: dokumentas išsaugomas ir tada uždaryti.  
• Atmesti: dokumentas yra uždarytas, ir visi nuo paskutinio įrašymo bus prarasti pakeitimus.  
• Atšaukti: Nieko neįvyksta, ir grįšite į dokumentą.  
 
Norėdami uždaryti LibreOffice visiškai, pasirinkite File → Exit.  
Nauja pakuote yra tik vienas tuščias skaidrę. Norėdami įterpti skaidres turite:  
• Įterpti> Pristatymas.  
• Dešiniuoju pelės mygtuku spustelėkite ant šios skaidrės, ir pasirinkite Skaidrių> Nauja skaidrė iš 
pop-up meniu.  
• Spustelėkite skaidrę piktogramą įrankių juostoje pristatymas.  
 

 

Iliustracija 75: The Presentation toolbar in LibreOffice 

Kartais, o ne nuo naujos skaidrės norite dubliuoti skaidrę jau įdėta. Norėdami tai padaryti pasirinkite 

skaidrę, kurią norite kopijuoti iš Skaidrės srityje ir pasirinkite Įterpti -> Duplicate Slide.  
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Norėdami pasirinkti maketą:  

Srityje Užduotys, pasirinkite Layout stalčių rodyti turimus maketus. Išdėstymai skiriasi elementų 

skaidrių būtų numatytos skaičių, iš tuščio skaidrę į skaidrę su šešių Turinys dėžės ir pavadinim. 

 

Iliustracija 76: Selecting the layout in Task pane 

1. Pirmoji skaidrė pristatyme paprastaipavadinimas skaidrių . Pavadinimas Pristatymas (kuris 

taip pat yra už subtitrų skyrių) arba pavadinimas Tik yra suilentelė maketai pirmą skaidrę , o 

labiausiai skaidres tikriausiai vadintis , turinio išdėstymas. Norėdami sukurti antraštę , 

spustelėkite Spustelėkite ir pridėkite pavadinimą (jeiTuščia Pristatymas išdėstymas nebuvo 

naudojamas) ir tada įveskite pavadinimą , tekstą. Norėdami reguliuoti pavadinimą 

formatavimą , pakeisti pavadinimą pristatymas stilių ; 

Jei norite pakeisti išvaizdą ty visų pateikties skaidrių foną , jūs turite pakeisti skaidrių ruošinį 

arba pasirinkti kitą skaidrių ruošinį . Pristatymas Masterslide su nurodytu rinkinį savybių, 

veikia kaip šabloną ir yra naudojamas kaip atspirties taškas kuriant kitas skaidres . Šios 

charakteristikos apima fone objektus fone , formatavimo bet naudojamas teksto ir fono 

grafika. 

Impress turi fasuotų skaidrių meistrų, rastų puslapių šablonai skyriuje Užduočių srities 

spektrą . Tačiau , jei norite keisti foną , galite imtis nuorodą : 

• Pasirinkite Format> Puslapis ir eiti į Background kortelėje . 

• Pasirinkite norimą foną tarp vientisa spalva , gradientas , perinti ir bitmap . spragtelėjimas 

• Gerai, kad jį taikyti. 

Norėdami sukurti naują pateiktį naudojant pristatymas vedlys : 

1 . Pagal tipą , pasirinkite vieną iš variantų : 

• Tuščias pristatymas sukuria tuščią pristatymą. 

• Iš šablono naudoja šabloną jau sukurtas kaip už naują pristatymą pagrindu. Vedlys keičia 

parodyti galimų šablonų sąrašas. Pasirinkite norimą šabloną . • Atidaryti esamą pateiktį tęsia 

darbą anksčiau sukurtą pateiktį. 

vedlys pokyčiai norėdami esamų pristatymai sąrašą. Pasirinkti vieną norite. 

2 . Spustelėkite Pirmyn. 

3 . Pasirinkite pagal Pasirinkiteskaidrių dizaino projektavimas. Skaidrių dizaino skyriuje 

suteikia jums du pagrindinius pasirinkimus: pristatymas fonai ir pristatymai. Kiekvienas iš jų 

turi pasirinkimų skaidrių dizaino sąrašą. Jei norite naudoti vieną iš šių išskyrus <Original> , 

spustelėkite jį , pasirinkite jį. 
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4 . Pasirinkite, kaippristatymas bus naudojami pagal Pasirinkite išvesties terpėje. Dažniausiai 

pristatymai sukurtas kompiuteris ekranas , todėl jūs pasirinkite Screen . Jūs galite pakeisti 

puslapio formatą , bet kuriuo metu . 

5 . Spustelėkite Pirmyn. Atrodo,pristatymas vedlys 3 žingsnis. Pasirinkite norimą skaidrių 

perėjimą nuo Effect išskleidžiamajame meniu . Pasirinkite norimą greitį tarp skirtingų skaidrių 

perėjimo iš Greitis išskleidžiamajame meniu pristatymas. Terpė yrageras pasirinkimas dabar. 

6 . Spustelėkite Kurti. Nauja pakuote yra sukurti.  

3.4 Internetinės mokymosi aplinkos 
E-mokymosi iškyla kaip nauja paradigma šiuolaikinio mokslo. Dabar naršo žinių valdymas ir dalijimasis 

informacija, padeda užtikrinti asmenų teisę naudotis žinių paprastu ir prieinamu būdu. Tolesniuose 

skirsniuose mes nurodyti potencialą:  

• Galimos interneto išteklių kurti ir bendradarbiauti su dokumentais.  

• Populiarus E-mokymosi sistemų (ypač ATutor ir Moodle) ir ką jie turi pasiūlyti.  

• kokiu mastu elektroninio mokymosi programos gali būti naudojami, siekiant konkrečių tikslų 

veiksmingai ir efektyviai konkrečiame kontekste naudojimui.  

On-line aplinka plėtoti ir įgyvendinti technologijas, siekiant pritraukti vartotojus į daugiau įdomių 

naujų būdų, siekiančių juos savo požiūriu ir įrenginių bei jų informavimas, dalyvauja ir 

bendradarbiauja kartu. 

3.4.1 ATutor 

3.4.1.1 Apžvalga 
ATutor yra nemokama žiniatinklio LMCS-mokymosi turinio valdymo sistema sukurta siekiant būti 

mokymo ir mokymosi priemonė, kuri gali būti arba internete, arba per organizacijos intranete.ATutor 

bendruomenė labai pritaria.Modulių skaičius egzistuoja, kad pratęsti ATutor savybių ir gali padėti 

besimokantiesiems ir mokytojams bendrauti, bendradarbiauti, kurti prieinamas formas ir tyrimus, 

praktiškai momentiniù prane ¹ imù, atlikti balta lenta pristatymai mokomosios medžiagos, ir dar 

daugiau.  

Mokytojas palaiko prieinamumo standartus, kurie yra kotiruojami žemiau:  

• W3C WCAG 1.0  

• W3C WCAG 2.0  

• 3C ATAG 2,0  

• 508 JAV dalis  

• Italija Stanca aktas  

• IMS AccessForAll 2,0  

• ISO / IEC 24751  

Be to, ji palaiko tokias sąveikos standartus:  

 OpenSocial 1.0 

 OAuth Authentication Protocol 

 IMS Content Packaging 1.1.2+ 

 SCORM Content Packaging  

 SCORM 1.2 LMS RTE3  
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 IMS Question Test Interoperability (QTI) 1.2/2.1 

 IMS BasicLTI 1.0 (reg. IMSB2ar2011W1) 

 IMS Common Cartridge 1.0 (reg. IMSA2ar2011W1) 

 W3C XHTML 1.0 
 

3.4.1.2 Prisijungimas ir registracija  
Nuo ATutor besimokantįjį, kursai ir ryšių linijos yra skirta ugdymo sąveikos individualiai. Viena iš 

pasekmių šio metodo yra tai, kad kiekvienas studentas turi turėti atskirą sąskaitą, kurioje asmeninį 

duomenis, paskaitas, įrašus, ryšių žurnalus ir mokomąją medžiagą, skirtos to kurso (ir labai dažnai 

tam konkrečiam studentui) gali būti laikomas. Ypač padidėjo konfidencialumas mokymo proceso 

metu reikalingas studentams su negalia ir konkrečių kultūrinių poreikių.  

Kiekvienas studentas turi atidaryti sąskaitą su prisijungimo vardu ir slaptažodžiu.Pirmas puslapis 

studentas mato yra prisijungimo puslapį, kur studentas arba rąstų arba registrai sukurti paskyrą (jei 

studentas apsilankymą prisijungimo puslapį, pirmą kartą). Tuo atveju, jei jis / ji pamiršta jo / jos 

slaptažodį, gali spustelėti nuorodą "Pamiršote slaptažodį?" Ir įvedę vartotojo elektroninio pašto 

adresą, į kurią tada bus išsiųstas slaptažodis.  

 

Iliustracija 77: ATutor login & registration page 

Norėdami užsiregistruoti pirmą kartą studentas turi įvesti asmeninę informaciją, kad ji / jis gali būti 
lengvai atpažįstami pagal kursų instruktorius ir administratorius, kai būtina.  
Studentai gali prisijungti įvedę savo vartotojo vardą (arba elektroninio pašto adresą) ir slaptažodį ir 
įveskite ATutor montavimą ant konkretaus serverio per interneto naršyklę. Studentai bus pateiktas 
"Mano kursai" ekraną, kuris tikrai turi ant viršaus nuorodų Naršyti Kursai ir sukurti Kurso ekraną 
.  

http://www.imsglobal.org/ProductDirectory/productdirectory1.cfm?auto=1326
http://www.imsglobal.org/ProductDirectory/productdirectory1.cfm?auto=1326
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Iliustracija 78: ATutor registration details 

3.4.1.3 Profilis ir pasirinkimai 
Aprašymas ir Nuostatos skirtukai galima rasti puslapyje.Studentas gali keisti skirtuke Profilio jo / jos 

profilio duomenis o skirtuke Nuostatos jie gali pakeisti kai kurias pagrindines nuostatas, susijusias su 

pašto dėžutę pranešimą, automatinio prisijungimo funkcijos, tipo turinio redaktorius, temą 

numeravimą ir tt Studentai gali pamatyti kursus, kurie yra prieinami sąrašą spaudžiant nuoroda 

Naršyti kursai apie Mano kursai ekrane. 



 
 
ViPi Project 511792-LLP-1-2010-1-GR-KA3-KA3NW  
 

www.vipi-project.eu Page 53 

 

Iliustracija 79: ATutor “My Start Page” 

3.4.1.4 Kursų peržiūra 
Ekrano Peržiūrėti kursai yra padalintas į tris stulpelius: iš Naršymo Kursai ekranas, kuriame 

pateikiama nemažai kursų kategorijas, kolonėlės kursų per pasirinktą kategorijos sąrašą, ir trečias, 

kuris informuoja studentus išsamiai apie pasirinktą kursą sąrašą stulpelis . Į kiekvieną kursą 

duomenys rodomi kaip antai kurso, pavadinimas instruktorius su galimybe kreiptis į kursų 

instruktorius ir prieigos atitinkamo kurso tipo pavadinimą.  

Paspaudus "Susisiekite su instruktoriumi nuorodą vartotojas bus pasiūlyta kartu su forma išsiųsti 

elektroninį laišką su instruktoriumi. Prieiga prie kursai gali būti saugomas arba visuomenei. 

Pastaruoju atveju prieigos gali būti leidžiama be išgyvena prisijungimo tvarka. 

3.4.1.5 Kursų kūrimas ir pasirinkimų nustatymas 
Kai administratorius prisijungia jie parodė meniu ir submeniu sąrašas pateikiamas kaip hipersaitus. Jie 

gali būti atvertas tiesiog paspaudę ant tinkamo hipersaito, skirtuke arba paspausdami klavišus Alt + 1, 

Alt 2, 3, Alt Alt 4 arba Alt 5 priskirtus už skirtukus iš kairės į dešinę. Labai svarbu, kad pagrindiniai 

klavišai apibrėžta tokiu būdu, nes net žmonės su tam tikromis negalia gali administruoti Atutor. 

. 
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3.4.2 Moodle 
Moodle yra nemokama interneto programa, kuri pedagogai gali naudoti norėdami sukurti interneto 

mokymosi svetainėse. Moodle funkcijos "modulinė" konstrukcija naudojant modulines objektinių 

dinamišką mokymosi aplinką. Moodle buvo sukurta siekiant padėti pedagogams kurti internetinius 

kursus daugiausia dėmesio skiriant sąveikai ir bendradarbiavimu grindžiamą mokymosi.  

Dinaminės mokymosi priemonės yra prieinamos per Moodle. Tai atviro kodo įrankis remiasi socialine 

konstrukcionistinę pedagogikos - Tai yra apibrėžiamas kaip aktyvaus mokymosi socialiniame 

kontekste, vyksta mokymosi aplinką su pažangių ir interaktyvių priemonių.  

Moodle turi keletą funkcijų, laikoma tipiška e-mokymosi platformą, plius keletą originalių naujoves 

(pavyzdžiui, jo filtravimo sistema). Kai kurie tipiniai bruožai Moodle pateikiamos tolesniuose 

skirsniuose. 

3.4.2.1 Priskyrimas pareigų 
There are four standard assignment types, but there are several other contributed assignment types 

which can be downloaded from the modules and plugins database.  

 

Iliustracija 80: Moodle assignment options 

• Išplėstinė Siuntimas failų: studentai gali pateikti vieną ar kelis elementus, pavyzdžiui, žodžio 

apdoroti dokumentus su užrašu jų mokytojas.Mokytojas gali pakomentuoti ir išsiųsti įkeltą failą.  

• Online tekstą: studentai gali įvesti savo atsakymą tiesiogiai Moodle naudojant tekstų redaktorius  

• Įkelkite vieną failą: studentai paprastai pateikti vieną darbelis, pavyzdžiui, žodžio apdoroti 

dokumentą ar prezentaciją  

• Atsijungęs užduotis: ne "tikroji" perleidimas bet mokytojui vieta pridėti klases atliktą darbą už 

Moodle.  

Studentai gali pateikti savo užduotis su ákëlimas vieno failo ir Advanced įkėlimo failų 

užduotis.Mygtukas "Įkelti failą" imsis juos į failų rinktuvai, kur jie rasti savo failus.  

 

Iliustracija 81: Submit an assignment 

http://moodle.org/plugins/browse.php?list=category&id=12
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3.4.2.2 Discusijų forumas 
 • Diskusijų forumas leidžia dalyviams bendrauti internetu, naudojant tekstą. Moodle leidžia 

konsultantams įsteigti ir coniliustracija interneto forumuose grupių ar pogrupių studentų, 

kurie gali sudaryti tekstas ir kitas žiniasklaidos priemones. Forumai yra naudingas, ir gali būti 

naudojamas taip:  

• Kaip grupės formavimo ir klijavimo "check-in" erdvės ne kurso pradžioje.  

• A klasės mokytojas gali nurodyti svarstymą ir paprašyti atvirą klausimą, pavyzdžiui, 

"komentaruose".  

• A klasės mokytojas gali rašyti dokumentus su konkrečiais klausimais, į kuriuos reikia 

atsakyti re medžiagos.  

• Kai studentai privalo rašyti pristatymas medžiagą prieš seminarą su arba be kviečia 

vertinamos.  

• Dėl abipusės paramos ir / ar mokymosi bendradarbiaujant, kai mokiniai yra fiziškai 

nuotolinio - paskirties vietas, pavyzdžiui, ir rizikos nesijaustų izoliuoti  

• Kai yra poreikis fiksuoti įnašų ar manoma processe 

3.4.2.3 Bylų atsisiuntimas 
The File download portfolio allows for easy download of content in Moodle activities. To enable file 

download:  

 Go to Settings > Site administration > Plugins > Portfolios > Manage Portfolios 

 Select from the drop down next to File download "Enabled and visible"; 

 

Iliustracija 82: Download a file 

You have to click on the “Settings” and optionally give File download a customised name.  

3.4.2.4 Vertinimas 
Kokybės elementas yra elementas (paprastai veikla), jei kurso dalyviai vertinami pažymiu arba ženklu. 

Kaip, pavyzdžiui, kokybės prekės už klasių konteinerių ir parametrai taikomi šių rūšių rinkinys. 

3.4.2.5 Realaus laiko žinutės 
Dauguma sąveika vyksta mažame lange, kuris atrodo kaip MP lange (kurią galite išplėsti į norimo 

dydžio). Jame yra keli skirtukų jums persijungti tarp prane ¹ vartotoją, ieško vartotojų ir skaityti 

suarchyvuotus pranešimus.  

Ji pasirodo (arba priekyje), kai:  

• paspausite ant virtualiame vartotojų sąrašą vardu  

• Paspaudus ant bet kurios dalyviai puslapyje nuorodą  
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• Paspaudus bendro nuorodą dalyvių bloko  

• turite naują pranešimą, kurį gavote 

 

3.4.2.6 Internetinis kalendorius 
The calendar can display site, course, group and or user events in addition to assignment and quiz 

deadlines, chat times and other course events. 

 

Iliustracija 83: Moodle online calendar 

3.4.2.7 Internetinis testavimass 
Moodlešablonas pagrįsta sistema , kuriai turinys turi būti pridedamas . Jo sąsaja yra intuityvi ir lengva 

navigacija. Visas puslapis yra pateikiama " Flat View " formatu. Kaip Robb ( 2004 ) apibūdina jį , tai 

skiriasi nuo kitų sistemų, kurios dažnai naudojasi " Kinijos dėžes " su turiniu viduje aplankus įvairiais 

lygmenimis . Kiekvienas skyrius turi savo įrankius, tokius kaip pamokos, viktorinos , užduotys , ir 

forumuose, siekiant didinti studentų nuomonei . 

Prieiga prie beveik visų pamokų užduotis gali būti daug laiko ar slaptažodį apribotos . Moodle taip pat 

taupo automatinis žurnalo ataskaitas studentų dirba individualiu lygmeniu . Todėlmokytojas yra 

informuojama ne tik apie laiką , kad studentai yra baigę arba įkeliami užduotį , bet taip pat laiko, kad 

jie , praleistas žaidžiant priskirtos užduoties ar testą . 

Viktorina modulis apima šias atsako tipai: Fill- in, variantais , variantais ( daugiau nei vienas 

atsakymas galima pasirinkti ), tiesa klaidingas , suderinimas , trumpas atsakymas (tiksli atitikimo ). Visi 

tipai yra palaikomi su automatiniu skaičiavimas ir vertinimo , remiantis mokytojo ar mokinių 

nustatytą reitingų skalės. 

3.4.2.8 Wiki 

Studentai gali būti skirstomos į pogrupius, bendrauti tarpusavyje sinchroniškai pokalbių kambariuose, 

ar užsiimti asinchroninis diskusijų Wiki ir forumuose.Wiki Moodle leidžia studentams kurti ir dirbti 

kartu dėl teksto, o internete.  

 Wiki (žodis Havajų už "greitai!") Yra tinklalapių internete, kad gali būti serija iš karto ir lengvai 

redaguoti bet kas su slaptažodžiu prie wiki. Jie bendradarbiavimo erdves internete, kur jūs galite 

dalytis ir kurti informaciją tarp vartotojų skaičių.  

Kai wiki nereikia slaptažodį ir yra atviri visuomenei (www.wikipedia.org). 

http://www.wikipedia.org/
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 Wiki bendradarbiavimo, nes ji gali būti atnaujinama ir redagavo keletą žmonių.Iš wiki 

turinys priklauso nuo jūsų.  

1. Kaip pradėti savo wiki  

Keletas skirtingų svetainių siūlo nemokamą wiki paslaugas, bet vienas iš 

paprasčiausių naudoti yra pbwiki (trumpinys "žemės riešutų sviestas, wiki" - "lengva, 

kaip žemės riešutų sviestas, sumuštiniai", sako pbwiki svetainė).  

• Norėdami sukurti pbwiki wiki, eikite į www.pbwiki.com, ir pamatysite šį ekraną.  

 

Iliustracija 84: Creating a wiki in pbwiki 

Give your wiki a name, which will be its web address. The wiki in the screenshot is called 

etwinningwiki – note that your wiki name must have no spaces, and can consist of letters and/or 

numbers.Then type in your email address, and click on ‘Make a wiki’. The screen below will appear: 

 

Iliustracija 85: “Making a wiki” 

Confirm your wiki and set a password. Afterwards an email will be sent to your mail address asking 

you to click on a link to set your wiki’s password. The email is like Iliustracija 86. 
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Iliustracija 86: Set your wiki’s password 

Vadovaukitės instrukcijomis, paspaudę nuorodą laiške, ir jūs pateksite į puslapį, kuriame galite 

nustatyti slaptažodį savo wiki. Jūs turite įvesti slaptažodį į "Pasirinkite slaptažodį" lange ir vėl 

"Patvirtinti slaptažodį" langelyje. Turite užsirašykite ir atsiminkite savo wiki slaptažodį! Jei nenorite, 

kad jūsų wiki prieinama visuomenei, nuimkite varnelę, kad sako "Make my wiki visuomenei". 

Spauskite ant "Paimkite mane į wiki".  

2. Redaguokite savo wiki puslapyje.Pirmame puslapyje savo wiki, šiuo metu atrodo taip:  

 

Iliustracija 87: Editing your wiki 

Jūs turite paspausti mėlyną mygtuką instrukcijų "Redaguoti šį puslapį" ant apatiniame kairiajame 

ekrano kampe.Sveiki informaciją taip, todėl dabar galite ištrinti visus, ir pakeisti jį įvadas į savo wiki. 
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3.5 Praktinės užduotys 

3.5.1 Apsipirkimas Amazon.co.uk 
Search for Amazon on Google. Go to Google.co.uk and type Amazon and hit the magnifying glass 

search button. 

 

Iliustracija 88 : Finding Amazon using Google 

Click on the link to be directed to the Amazon.co.uk homepage 
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Iliustracija 89 : Signing up as a new customer 

You will need to register as an amazon user. To do this you need an email address. Fill in your email 

as in the example above and ensure ‘no, I am a new customer is checked’. Click sign in using secure 

server. 
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Iliustracija 90 : Creating an Amazon account 

You will now notice the https:// has appeared at the start of the URL accompanied by a lock symbol. 

This capture is from Google Chrome, so yours may look slightly different, but it should still be 

displaying the https and a lock symbol. 

Enter a password, and enter it again in the second box. This is to ensure you typed it correctly. Click 

on create account. 
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Iliustracija 91 : The new customer welcome page 

Dabar pateksite Amazon kaip prisijungęs vartotojas. Atkreipkite dėmesį, kad tai dabar nėra saugi 
puslapis (ne "https" arba užrakto simbolis yra). Taip pat atkreipkite dėmesį langą sako "Labas Andy 
Bloggs turime rekomendacijas (ne Andy?). (Andy Bloggs reikėtų pakeisti vardą, kurį įvedėte.) 
Rekomendacijos nėra naudinga, nes dar, bet, kaip jūs naudojate "Amazon", jo protingas paieška 
bandys rekomenduoti elementus, kurie, jos nuomone, jums gali būti įdomu, pagal tai, ką turite 
pažvelgė anksčiau. Kaip naujas klientas galite tinkinti savo įspūdžius pasakoja Amazon jūsų interesai, 
arba tiesiog gauti ir ieškoti, ką jūs norite pirkti, kaip mes bus padaryti kitą. 
. 
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Iliustracija 92 : Typing a search into the search bar - in this case we want to find music by the band "New Model Army" 

In Iliustracija 92 we see that the search bar has some text entered in it. Try this yourself and hit the 

go button. 
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Iliustracija 93 : The results of the search 

Turėtumėte gauti paieškos rezultatus, panašiai kaip į iliustracija 94 vienos sąrašą. Kiekvienas 

išvardytos prekės turi santrauką info apie tai. Kiek tai kainuoja, bet pagal kurį pardavėjas, kas jis yra - 

šiuo atveju CD, įvertinimą žvaigždutėmis, sakau, ką kiti pirkėjai minties produktas, ką Pristatymo 

sąlygos būtų galima 

. 
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Iliustracija 94 : Examining the details of a product 

Paspaudę vieną iš sąraše esančių elementų leidžia atidžiau jį (kaip iliustracija 95). Tai gali suteikti kelis 

vaizdus, detales, kai ji bus prieinama, detalesnis aprašymas elemento, apžvelgiama kitų pirkėjų, jei 

įmanoma, arba pilna specifikacija prekę. 
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Iliustracija 95 : Adding the item to your shopping basket 

Clicking on the ‘Add to basket’ item places the item, ready for buying, into a virtual shopping basket. 

Once in the shopping basket, items are saved ready for you to check out later. More items can be 

added and items can be easily removed from the basket. 
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Iliustracija 96 : Viewing the shopping basket 

You will see that the basket icon near the search bar now has a 1 in it representing the 1 item in your 

basket. We can click this button to see the shopping basket, and to remove items from it if we so 

desire. Clicking the Proceed to checkout button will move us on to buy what is in our shopping 

basket. 
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Iliustracija 97 : checking out - firstly signing in to 'secure server' 

Pirmasis etapas iki patikrinti prisijungia vėl į saugiame serveryje. Šis procesas leidžia 
tinklapyje šifruoti slaptus duomenis galima perduoti, pavyzdžiui, savo adresą ar kortelės 
duomenis. Be iliustracija 98 dabar mes galime naudoti antrą parinktį "Aš esu užsiregistravęs 
klientas" ir prisijunkite naudodami mūsų slaptažodis sukurta anksčiau 
. 
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Iliustracija 98 : Entering the delivery details 

Kai prisijungiate atgal turime patekti į mūsų adresas. Svarbu tai yra teisinga, nes ji yra ten, kur prekės 

ir sąskaitos bus išsiųstas. Paprastai pirmą kartą įsigyjant prekes turi būti išsiųstas adresu, kuriuo 

kredito kortelė yra registruotas, taigi turėkite tai omenyje savo pirmojo pirkimo. 
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Iliustracija 99 : Filling the form in 

Formą galima užpildyti naudojant pelę norėdami pasirinkti laukus įvesti arba naudojant skirtuką 

mygtuką judėti tarp laukų. Spustelėkite toliau, kai visi duomenys yra įvesti. Jei praleidote ir duomenų 

arba padarė klaidą, forma gali pastebėti ir paprašys ją ištaisyti. 
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Iliustracija 100 : Selecting the postage options 

"Amazon" siūlo kelis parašėte galimybes, kurios galite pasirinkti priklausomai nuo pirkimo 

skubumą.Nemokamas pristatymas dažnai yra lėtas, bet brangesnis kitą dieną pristatymas gali būti 

prieinami. 
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Iliustracija 101 : Entering card details 

Galiausiai mokėjimo detales prašoma. Tai reiškia patekti į ilgai kortelės numerį iš savo kortelės, 

galiojimo data, pradžios data arba numeris, o dažnai ir 3 skaičių apsaugos kodą iš kortelės pusėje. 

Visada įsitikinkite, kad jūs naudojate saugų HTTPS ryšį prieš įvesdami tokius duomenis į 
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svetainę.

 

Iliustracija 102 : Final review screen before check out 

Galiausiai iliustracija 103 matome, kad "Amazon" siūlo galutinį galimybę patikrinti, ką jūs perkate, kur 

ji eina ir koks metodas kokia kaina. Paspaudę "Vieta jūsų užsakymą" mygtuką, bus užbaigti pirkimą. 

Tai daryti tik jei tikrai norite pirkti objektą! 
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Iliustracija 103 : Confirmation of order screen 

Jei paspausite "Patvirtinti užsakymą" mygtuką, bus rodomas patvirtinimo puslapį kaip iliustracija 104. 

Tai bus nurodyta tvarka numerį, jei jums reikia jį ateičiai atveju jokių problemų su pristatymo ar 

netinkamo produkto - arba jūs turėtumėte tiesiog nusprendžia grįžti elementą. Visi šie duomenys bus 

išsiųstas į elektroninio pašto adresu, nurodytu adresu žurnale savo įrašais ir visa informacija yra taip 

pat laikomi saugiai per Amazon sistema. 

Šis procesas yra panašus į tą, kuri naudota daugelyje internetinių parduotuvių, ir tai leis jums pirkti 

prekes ir paslaugas iš įvairių tiekėjų. Visada įsitikinkite, kad svetainė yra repulentelė prieš bandant 

įsigyti prekių iš jo.Saugumo sertifikatas turėtų galioti. Tai galima patikrinti paspaudę užrakto 

piktogramą URL juostoje. Prašome kreiptis į interneto saugumo natomis į 2,6 ir 2,12 skyriuose žinoma 

daugiau informacijos apie tai. 


